THE DIAMONDBACK
The #1 way to reach 48,000 University of Maryland students, faculty & staff.
DBKNEWS.COM
Download on the App Store
Download on Google play
About
Learn about The Diamondback and view contact information.

Audience
See statistics relating to Diamondback readers.

Schedule
Special content publication schedule for both Print & Online.

Orientation Guide
Get your message directly into the hands of all incoming students and their parents.

Terp Housing
Put your message directly into on-campus residence halls throughout the year.

Newsstand Posters
Place your highly visible, full-color poster on one of our high-traffic newsstands.

Promo Squad
Put your event flyer or coupon directly into the hands of UMD students, faculty & staff.

Online Rates
Rates for advertising on DBKnews.com.

Crossplatform Ads
Ads that appear on both mobile & desktop.

Sponsored Content
Ads integrated into other Diamondback content.

Social Networks & Email
Ads that appear on Twitter, Facebook, and Diamondback emails.

Creating Your Ad
View instructions for creating ads for The Diamondback online or in print.
The Diamondback, the University of Maryland's independent student-run newspaper is published by Maryland Media Inc. – a 501c3 nonprofit.

Published continuously since 1910, The Diamondback is College Park’s only newspaper and #1 source for news, sports, and entertainment and is published continuously online daily at DBKnews.com. The Diamondback reaches 100,000 readers each week and is regularly recognized for editorial excellence, including being named the #1 college newspaper in the country four times by the Society of Professional Journalists.

Address
Published by Maryland Media Inc.
3136 South Campus Dining Hall
College Park, MD 20742
301.314.8000

Staff
Editor-in-chief: Daisy Grant
Business Manager: Craig Mummey
General Manager: Arnie Applebaum
Advertising Director: Ayla Kinnaird
Advertising Manager: Sophia Alexander
Advertising Manager: Bridget Brown
Advertising Manager: Ethan Tuttle

Advertising email: dbkadvertising@gmail.com

WHY ADVERTISE?

Brand Recognition
Make your business known to UMD students.

Website Conversions
Advertise on dbknews.com to see more traffic driven to your website.

Increase Sales
Adding coupons & special deals brings customers to your business.
### Where Do College Students Spend Their Money?

<table>
<thead>
<tr>
<th>Category</th>
<th>Average</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery Store purchases</td>
<td>5.9</td>
<td></td>
</tr>
<tr>
<td>Restaurant purchases</td>
<td>5.7</td>
<td></td>
</tr>
<tr>
<td>Bar purchases</td>
<td>4.1</td>
<td></td>
</tr>
<tr>
<td>Drug Store purchases</td>
<td>3.4</td>
<td></td>
</tr>
<tr>
<td>Students taking winter</td>
<td>65%</td>
<td></td>
</tr>
<tr>
<td>or summer classes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Students planning to</td>
<td>85.2%</td>
<td></td>
</tr>
<tr>
<td>attend a grad program</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Statistics

- **$650 Million**: The amount spent each year by College Park's students, faculty & staff.
- **21**: The average age of all the University of Maryland students.
- **47,964**: The total number of students at the University of Maryland.

- **91%**: The number of students, faculty & staff who read The Diamondback at least once a week.
- **72%**: Amount of student income used for dining, drinks & snacks.
- **56%**: University of MD students with a paid job.
- **36%**: University of Maryland students who are from Out-of-State.
<table>
<thead>
<tr>
<th>PRINT</th>
<th>ONLINE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product</strong></td>
<td><strong>Product</strong></td>
</tr>
<tr>
<td>Welcome Back</td>
<td>March Madness</td>
</tr>
<tr>
<td>Basketball Preview</td>
<td>Salary Guide</td>
</tr>
<tr>
<td>Terp Housing</td>
<td>Orientation Guide</td>
</tr>
<tr>
<td>Coloring Book</td>
<td>Welcome Back</td>
</tr>
<tr>
<td>Looking Back</td>
<td></td>
</tr>
<tr>
<td>Orientation Guide</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Publication Date</strong></td>
<td><strong>Publication Date</strong></td>
</tr>
<tr>
<td>August 24, 2020</td>
<td>March 15, 2021</td>
</tr>
<tr>
<td>November 2, 2020</td>
<td>April 26, 2021</td>
</tr>
<tr>
<td>November 30, 2020</td>
<td>May 14, 2021</td>
</tr>
<tr>
<td>December 7, 2020</td>
<td>August 30, 2021</td>
</tr>
<tr>
<td>April 26, 2021</td>
<td></td>
</tr>
<tr>
<td>May 21, 2021</td>
<td></td>
</tr>
</tbody>
</table>

**Basketball Spirit Papers**

*Spirit Papers are placed on EVERY STUDENT SEAT at the top basketball games each season!*

**Terp Housing Guide**

*Distributed on campus including dormitories. With only freshmen and sophomores living on campus, this audience needs to find somewhere off campus to live by their junior years.*

**Looking Back**

*The Diamondback Congratulates the Class of 2021. Distributed throughout campus with supplemental distribution at the main commencement ceremony. Ideal for graduate schools, employers and local businesses trying to reach this valuable audience.*

**Salary Guide**

*We’ve pledged to hold the University of Maryland accountable in our coverage. Our annual salary guide lays out each university employee’s yearly pay in an easily digestible format. Don’t miss this chance to be included in our MOST sought after publication of the year!*

**Orientation Guide**

*Pay once to be in every single incoming freshmen and their parents’ hands at all summer orientation sessions. Gain loyal customers the very first time they are on campus after their acceptance.*

**Welcome Back**

*The Diamondback’s Survival Guide will be the student’s keepsake resource for surviving the academic year. Students receive their guide during move-in and will refer back to it throughout the year, from tips for finding late-night meals to figuring out the best way to travel to D.C.*
ORIENTATION GUIDE

Get your message directly into the hands of all incoming students AND their parents! Your ad in the Orientation Guide will be distributed to all summer orientation visitors — 15,000 copies all for one LOW cost! Distribution directly to all new students and their parents at every summer orientation session.

The DBK Orientation Guide will also be available at the highest traffic locations and buildings all summer long – including the Stamp Student Union, the libraries and orientation dorms. Everyone knows that first impressions are the most important. The Orientation Guide enables you to reach all these new orientation visitors — 15,000 copies all for one LOW cost! Distribution directly to all new students and their parents at every summer orientation session.

Every page and every ad is in color for no additional cost. Pulishes: May 21, 2021 • Ad Deadline: April 30, 2021.

POSITIONS

Premium
Back Cover 9.44"x10" $2800
Inside Front Cover 9.44"x10" $2700
Page 3 9.44"x10" $2700
Center Spread 19.88x10" $4300
Pop-Up Ad 19.88"x1.375" $3000
Post-It Note on Cover* 3"x3" **trimmed to 2.875"x2.875" $3000

Standard
Full Page Ads 9.44"x10" $2100
Half Page Ads 4.65"x10" $1300
Half Page Ads 9.44"x5" $1300
Quarter Page Ads 4.65"x5" $800

AD SPECS

Full Page 9.44" wide x 10" tall
Half Page Horizontal 9.44" wide x 5" tall
Half Page Vertical 4.65" wide x 5" tall
Post-It Notes 3" wide x 3" tall (trimmed to 2.875" x 2.875")
Coupons 1.788" wide x 2" tall

DEADLINES

Publication Date May 21, 2021
Space Reservations April 30, 2021
Art April 30, 2021
Camera-Ready Art May 7, 2021

INSERTS (prices include printing on 60lb gloss)

Pre-Printed Inserts $3000
Pre-Printed Inserts in conjunction $1800
with any Full Page Ad

Ask your sales rep for information about price reductions for self-printing.
TERP HOUSING GUIDE

Want to be considered one of the best off campus student housing options at the most crucial times? The Diamondback can put your message directly into on-campus residence halls throughout the year with Terp Housing. Pay once to be placed in campus residence halls 3 times during the year. With first and second year students living on campus, this audience will soon be looking for campus housing!


<table>
<thead>
<tr>
<th>Ad Type</th>
<th>Size</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Page Listing or Ad</td>
<td>5&quot;w x 8&quot;h</td>
<td>$2,000</td>
</tr>
<tr>
<td>½ Page Listing or Ad</td>
<td>5&quot;w x 3.9&quot;h</td>
<td>$1,250</td>
</tr>
<tr>
<td>First Full Page Premium</td>
<td>5&quot;w x 8&quot;h</td>
<td>$2,300</td>
</tr>
<tr>
<td>Second Full Page Premium</td>
<td>5&quot;w x 8&quot;h</td>
<td>$2,300</td>
</tr>
<tr>
<td>Back Page Premium</td>
<td>5&quot;w x 8&quot;h</td>
<td>$2,300</td>
</tr>
</tbody>
</table>

**Inserts**

Inserts may not be larger than a 5” x 7” card. Inserts cost $1000 as a stand-alone product, but that price is reduced to $500 with the purchase of any other housing guide ad. The prices listed do not include printing. The Diamondback can help with printing if needed (pricing will be determined by the job).

<table>
<thead>
<tr>
<th>Ad Type</th>
<th>Size</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>With Ad Purchase</td>
<td>5&quot;w x 7&quot;h max</td>
<td>$500</td>
</tr>
<tr>
<td>Stand-alone</td>
<td>5&quot;w x 7&quot;h max</td>
<td>$1,000</td>
</tr>
</tbody>
</table>
NEWSSTAND POSTERS

Place your highly visible, full-color poster on one of our high-traffic newsstands!
Posters are 19"w x 36"h or 26"w x 50"h in size.

$350/Month/Location
Supply your own posters or posters can be printed for an additional charge of $65.

$300/Month/Location
3+ locations in one month OR one placement in 3+ consecutive months. free poster printing included*

$250/Month/Location
3+ locations in one month AND 3+ consecutive months. Free poster printing included*

*Additional copy changes after first month will be charged $65 per poster changed.

Available Locations:
• Stamp Student Union
• McKeldin Library
• Hornbake Library
• Bagel Place
Coupons and Flyers Delivered by Hand!
Put your event flyer or coupon directly into the hands of UMD students, faculty and staff. Our talented marketing and design team can help you build dynamic and effective sales materials that WORK.

+ Brand Ambassador Services
Wearing Branded Clothing/Gear
Just $50 with the supply of sufficient quantity of company brand hats, shirts, etc. for the promo squad members.

Bulletin Board Posters
The Diamondback can get your message front and center in all the busiest parts of campus. Your poster or flyer will be posted where students spend the majority of their time.
$200 for 100 flyers
Design and printing services available

Sidewalk Chalking
Chalking: name/event, short phrase, URL (max 7 words + URL)
Cost: $35 per chalking, up to 3-4 colors
Size: standard 4x4 sidewalk square
Additional words/space at additional cost

DISTRIBUTION COST

<table>
<thead>
<tr>
<th>Pieces</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>$100</td>
</tr>
<tr>
<td>250</td>
<td>$250</td>
</tr>
<tr>
<td>500</td>
<td>$500</td>
</tr>
<tr>
<td>750</td>
<td>$675</td>
</tr>
<tr>
<td>1000</td>
<td>$700</td>
</tr>
</tbody>
</table>

FLYER PRINTING COST

<table>
<thead>
<tr>
<th>Amount</th>
<th>Single-Sided</th>
<th>Double-Sided</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>$45</td>
<td>$85</td>
</tr>
<tr>
<td>250</td>
<td>$65</td>
<td>$110</td>
</tr>
<tr>
<td>500</td>
<td>$110</td>
<td>$120</td>
</tr>
<tr>
<td>750</td>
<td>$135</td>
<td>$165</td>
</tr>
<tr>
<td>1000</td>
<td>$145</td>
<td>$190</td>
</tr>
</tbody>
</table>

Prime Campus Locations
(minimum 3 chalkings per location)
McKeldin Library
McKeldin Library mall pathways
Stamp Student Union
South Campus Dining Hall
Hornbake Library
Gen Z and millennial users are true digital and mobile natives consuming 70% of their news content on their mobile devices. Diamondback digital advertising is sold on a cost-per-thousand impression basis and will appear on all of our digital platforms and in a variety of ad sizes until the advertisers budget and impression goals are fulfilled.

Banner Advertising (cost per thousand impressions)

- $10 - The University of Maryland, Nonprofits and Student Groups
- $11 - Standard Rate
- $12 - National Advertisers
- $15 - Specified Banner Positions

Making your own ad? See the Creating An Ad section.

Text Links
These appear in the sidebar of each desktop and mobile page.
$50 per Month
CROSSPLATFORM ADS

Billboard “Takeover” Ads
A premium position on DBKnews.com. Relevant advertising is highly valued by our readers and messages appearing in these positions consistently achieve:

- High Engagement
  - Billboard ads often gain much higher engagement than standard ads, appearing at the top of the page so users will view them before moving on to any other content.

- High Conversion Rates
  - People who interact with takeover ads convert to buyers or users at higher rates relative to other online ad formats.

- Flexible Delivery
  - Advertisers have flexibility on timing and structure of these ads. Compelling images, interactive quizzes, and other creative engagement mechanisms are all possible.

1000*300 • Desktop Billboard
*background will be added to add an additional 920px

- 100% of impressions / week: $600
- 100% of impressions / day: $100
- 50% of impressions / week: $350
- 50% of impressions / day: $75

400x200 • Mobile Billboard

- 100% of impressions / week: $600
- 100% of impressions / day: $100
- 50% of impressions / week: $350
- 50% of impressions / day: $75

250x120 • Sidekick

- $500/week or $150 per day
  - Includes all mobile & desktop platforms
  - Appears once every 5 minutes for each visitor

Billboard Combination
Appears on both desktop & mobile

- 100% of impressions / week: $1000
- 100% of impressions / day: $200
- 50% of impressions / week: $750
- 50% of impressions / day: $150
On each purchased day of sponsored content the article:
- Appears on the homepage within other breaking news stories
- Gets posted onto The Diamondback’s Facebook wall
- Gets included in that day’s Diamondback e-mail newsletter
- Includes Twitter blast to the 23,000+ followers of @thedbk
People following facebook.com/TheDiamondback on Facebook.

People following @thedbk on Twitter.

Email Edition
Sent out to all of The Diamondback's 9,800+ email subscribers!
Your ad will be featured on an email sent every day Monday–Friday.

728x200 pixels
$150 per week

Direct E-mail
Direct E-mail Advertising to Current Students and Recent Graduates.
Perfect for education advertisers and employers!

1000 Minimum
$.50 per email address for random delivery to students & majors
$1.00 per email address for targeted delivery to specific majors

Sponsored Tweets
Tweet your message to over 23,800 followers on twitter.com/thedbk.
◆ Limit of 280 characters per tweet. Tweets must begin with "Sponsored:"
◆ You may include links and/or hashtags.
◆ You may include an image. Photo must be approved by deadline.
◆ $40 per tweet.
These are guidelines for creating your own ads.

PRINT

DO NOT INCLUDE CROP MARKS OR BLEEDS IN YOUR ADS.
The ads we receive should fit exactly to the desired ad space.

Color: CMYK
Use 100K for black areas/text, not a mix of CMYK colors to avoid blurring.
Images pulled directly from the internet will probably be in RGB, so be sure to check.

No Spot / Pantone Colors
Resolution: 300 pixels/inch
Save As: PDF (fonts embedded) or TIF (flattened, LZW compression)

CHECKING THE SIZE

Checking PDF Size in Acrobat
Drop your ad into Adobe Acrobat.
At the bottom, you should see a measurement. If not, you may need to turn on Rulers:
View > Show/Hide > Rulers & Grids > Rulers

Checking Size and Resolution in Photoshop
Drop your ad into Adobe Photoshop.
Go to: Image > Image Size

ONLINE

ADS OVER 50KB IN SIZE MAY BE RESAMPLED.

Color: RGB
Animated GIFs may require lowered color numbers to stay under the 50kb file size limit.
Transparency in GIFs and PNGs is not supported.

Resolution: 72 pixels/inch

Save As: PNG, JPEG, or GIF
If you are using Photoshop, simply use File>Save for Web. You ad’s file size must be under
50kb, PNGs are larger. JPEGs are great for blended colors and gradients. GIFs are best for
solid colors and will also allow some animation.